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Downloading Zaber's Libraries for Arduino 

1. Download and install the Arduino IDE. 

2. Open the Arduino IDE, and navigate to Sketch -> Include Library -> Manage Libraries...  

3. Within the window that opens, search within the Filter your search... box for "Zaber". 

4. Click on each library that shows up, then click the Install button. 
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アルデューノ用 Zaber ライブラリのダウンロード 

1. Arduino IDE のダウンロードとインストトール 

2. Arduino IDE オープンとスケッチ - >ライブラリを含める - >ライブラリの管理... への案内 

3. 表示されたウィンドウ内で、[検索を絞り込む...]ボックス内で "Zaber"を検索します。 

4. 表示されている各ライブラリをクリックしてから、[インストール]ボタンをクリックします。. 



This tutorial walks you through the details of setting up simple functional examples. For a crash course 

on getting a minimal example working on your Arduino, you can also see the Quick Start Guide. 

Connecting Your Zaber Device to an Arduino Board 

Arduino boards are like tiny computers, but they can only run one program at a time. This makes them 

inexpensive and useful tools for prototyping, testing, or in this case, interacting with motors. 

Zaber devices communicate with Arduino boards via serial communications. This means that a RS-232 

serial communications port and cable is necessary to connect the Arduino to a Zaber device. Zaber 

recommends the X-Series Shield which lets you talk to Zaber devices and to your debug Serial Monitor 

at the same time. If you're interested in using additonal serial ports for other devices, it's easiest to 

invest in a larger platform like the Arduino Mega. 

To complete this beginner's guide you will need: 

 A Zaber device 

 An Arduino Uno Rev3 or Mega Rev3 board 

 A USB cable to plug the Arduino into your PC (this should come with the Arduino) 

 An X-Series Shield for the Arduino 

 A X-DC data cable to connect the Zaber device and the X-Series Shield  

o A-Series and T-Series devices will instead require an S-XDC or a T-XDC, respectively 

The X-Series Shield allows you to power your Arduino from your Zaber X-Series device, which is 

useful when you have finished your program and want to run without being connected to the computer. 

For now though, it's best to power the Arduino over USB. 

 Make sure your Power Source jumper is in the "Vin/USB" position. 

Zaber's X-Series Shield uses I2C to communicate with the Arduino. For most cases, the default 

address AA will work. If you plan on using other shields that also use I2C, make sure you choose a 

unique I2C address for each shield. See Adding More Shields and Sensors. 

1. Connect the X-Series Shield (X-AS01) to your Arduino. 

2. Connect your Zaber device to the X-Series Shield with the correct data cable. 

3. Power your Zaber device. 

4. Connect your Arduino to your computer with a USB cable. The "ON" LED should light up on the 

X-Series Shield. 

 

このチュートリアルでは、簡単な機能例の設定の詳細について説明します。 ユーザの Arduino で動作する最小の例を得

ることに関する特別コースについては、クイックスタートガイドにてご覧いただけます。 

 Zaber デバイスを Arduino ボードへ接続 

Arduino のボードは小さなコンピュータですが、一度に実行できるプログラムは 1 つだけです。 これにより、プロトタイピング、

テスト、またはこの場合はモーターとのやり取りのための安価で便利なツールとなります。 

Zaber デバイスはシリアル通信を介して Arduino ボードと通信します。 つまり、Arduino を Zaber デバイス

に接続するには RS-232 シリアル通信ポートとケーブルが必要です。 Zaber は X-Series Shield を推奨し

ています。これにより、Zaber デバイスとデバッグ用シリアルモニターを同時に通信できます。 他のデバ

イスに追加のシリアルポートを使用したい場合は、Arduino Mega のような大規模プラットフォームをご検

討下さい。 

この初心者ガイドの説明対象商品： 

 Zaber デバイス（ステージ） 

 Arduino Uno Rev 3 または Mega Rev 3 ボード 

 Arduino を PC に接続するための USB ケーブル（これは Arduino に付属しているはずです） 

 Arduino 用のＸシリーズシールド 

 Zaber デバイスと X シリーズシールドを接続するための X-DC データケーブル 

 A シリーズおよび T シリーズデバイスには、代わりにそれぞれ S-XDC または T-XDC が必要です。 

X シリーズシールドを使用すると、Zaber X シリーズデバイスから Arduino に電源を供給できます。これ

は、プログラムを終了してコンピュータに接続しなくても実行したい場合に役立ちます。 しかし現時点で

は、USB 経由で Arduino に電力を供給するのが最善です。 

 電源ジャンパが "Vin / USB"の位置にあることを確認してください。 

Zaber の X-シリーズ Shield は Arduino と通信するために I2C を使用します。 ほとんどの場合、初期値のアドレ

ス AA で機能します。 I2C も使用する他のシールドを使用することを計画している場合は、必ず各シールドに固

有の I2C アドレスを設定するために、 必要なすべての Shield とセンサーの追加をご考慮ください。 

1. X シリーズシールド（X-AS01）を Arduino に接続して下さい。 

2. 正しいデータケーブルで Zaber デバイスを X シリーズシールドに接続します。 

3. Zaber デバイスに電源を入れます。 

4. USB ケーブルで Arduino をコンピュータに接続して下さい。 X シリーズシールドの "ON" LED が

点灯します。. 

X シリーズシールド 
    ＋ 

Arduino X シリーズデバイス 



Writing Code - The Arduino IDE 

Arduino programs are compiled and uploaded to an Arduino board using the Arduino IDE, available here 

for download. Once the Arduino IDE is installed and open on your computer, you should be presented 

with a screen similar to as follows: 

 

This is where all C++ code is written and compiled for Arduino boards. Code that is present in the 

setup() function will be run once, when the Arduino initially boots the program. Code that is present in 

the loop() function is called repeatedly, so long as the Arduino board has power and the program has 

not halted execution. 

Before trying to run any Arduino program, you must tell the Arduino IDE what type of Arduino you have 

and which port it is connected to on your computer. Refer to the Arduino IDE documentation. 

 

Simple ASCII Homing Example 

This section will show you the process of creating a simple program step by step, with explanation of 

the concepts. If you would prefer to jump directly to a complete program, you can open one of our 

provided examples in the Arduino IDE by navigating the menus to File -> Examples -> Zaber ASCII, 

where the completed example below is available as Basic_Homing. 

コードを書く - Arduino IDE 

Arduino プログラムは、Arduino IDE を使用してコンパイルされ、Arduino ボードにアップロードされま

す。こちらからダウンロードできます。 Arduino IDE をインストールしてコンピュータに開くと、次のような

画面が表示されるはずです。 

これがすべての C ++コードが Arduino ボード用に書かれコンパイルされている場所です。 setup（）関数

に含まれるコードは、Arduino が最初にプログラムを起動したときに 1 回実行されます。 Arduino ボード

に電源が入っていてプログラムが実行を停止していない限り、loop（）関数内にあるコードが繰り返し呼

び出されます。 

Arduino プログラムを実行しようとする前に、Arduino IDE にどのタイプの Arduino があり、どのポートが

コンピューターに接続されているかを伝えなければなりません。 Arduino IDE のドキュメントを参照して

ください。 

簡単な ASCII ホーミング（原点復帰）の例 

このセクションでは、概念を説明しながら、簡単なプログラムを段階的に作成するプロセスを説明しま

す。完全なプログラムに直接ジャンプしたい場合は、メニューから File - > Examples - > Zaber ASCII の

順に移動して、Arduino IDE で提供されている例の 1 つを開くことができます。そこには、Basic Homing 

(基本的原点復帰）動作の例が載っています。 



For now, let's write a simple program: When the Arduino turns on, we'll send the attached Zaber device 

back to its home position. As this command only needs to be issued once and not repeatedly, we can 

utilize the setup() function in this case, leaving the loop() function empty. 

Initializing Zaber's Libraries for Arduino 

If your device is in Binary mode, you will need to switch it to ASCII first. You can use Zaber Console to 

change your device's mode of operation. Under its Options tab there is a button to quickly change all 

devices between the ASCII and Binary protocols. For the sake of this example, we will assume that the 

device is in ASCII mode. 

The first thing to do is import the ZaberAscii library at the very top of your file. 

Common Questions 

What is a library? 

A library is a group of predefined functions that are distributed together. Importing the library allows us 

to utilize its functions for our own program. 

What is a function? 

A function is a short section of code that is named. It can be run from multiple places in a program 

using its name, to avoid duplicating the same code many times. 

How do I know what functions are available? 

In the example code below, "ZaberAscii.h" refers to a file that is distributed with the library, which you 

can open to see function declarations. Typically libraries include these .h files that you can refer to if 

other reference documentation is not available. This library does not include separate function 

reference documentation, so please refer to ZaberShield.h and ZaberAscii.h. On a Windows PC, the 

typical installed location of these files is Documents\Arduino\libraries\ZaberAscii. The reference 

for functions provided by Arduino can be found here. 

Create a new file in the Arduino IDE and add this line at the top: 

#include <ZaberAscii.h> 

Creating an Instance 

 

Now, we need to initialize an instance of the ZaberAscii class. When doing so, a Serial class must be 

passed through to the constructor. A Serial class controls communication with the Zaber device 

through serial ports. For all Arduino boards, the basic Serial class is available, as all Arduino boards 

possess at least one serial port. However, if your Arduino board has more than one serial port, the 

classes Serial1, Serial2, Serial3 are additionally available, allowing simultaneous control with non-

手始めに、簡単なプログラムを書いてみましょう：Arduino の電源が入ったら、接続されている Zaber

デバイスをホームポジションに送ります。 このコマンドは一度だけ発行すればよく、繰り返し発行する

必要はないので、この場合は setup（）関数を使用して、loop（）関数を空のままにすることができます。 

Arduino 用に Zaber のライブラリを初期化する o 

デバイスがバイナリモードの場合は、最初に ASCII に切り替える必要があります。 Zaber コンソールを

使用して、デバイスの動作モードを変更できます。 その[オプション]タブの下には、すべてのデバイスを

ASCII プロトコルとバイナリプロトコルの間ですばやく変更するためのボタンがあります。 この例では、

デバイスは ASCII モードであると仮定します。 

最初にすべきことはあなたのファイルの一番上に ZaberAscii ライブラリをインポートすることです。 

よくある質問 

ライブラリーとはなに？ 

ライブラリーは、一緒に配布されている事前定義関数のグループです。 ライブラリをインポートすると、その関数

を自分のプログラムに利用することができます。 

Function(関数)とはなに? 

関数は、名前が付けられたコードの短いセクションです。 同じコードが何度も重複するのを避けるため

に、その名前を使用してプログラム内の複数の場所から実行できます。 

どんな機能が利用可能かはどうすれば分かりますか？ 

以下のコード例では、 "ZaberAscii.h"はライブラリと一緒に配布されているファイルを参照しています。

このファイルを開くと、関数の宣言を確認することができます。 通常、ライブラリにはこれらの.h ファイ

ルが含まれており、他の参照ドキュメントが利用できない場合に参照できます。このライブラリには、個

別の関数参照ドキュメントは含まれていませんので、ZaberShield.h と ZaberAscii.h を参照してください。 

Windows PC では、これらのファイルの一般的なインストール場所は Documents \ Arduino \ libraries 

\ ZaberAscii です。 Arduino が提供する関数のリファレンスはここにあります。 

Arduino IDE で新しいファイルを作成し、この行を先頭に追加します。 

#include <ZaberAscii.h> 
 

インスタンスを作成する 

さて、ZaberAscii クラスのインスタンスを初期化する必要があります。 その際には、Serial クラスをコン

ストラクターに渡す必要があります。 シリアルクラスはシリアルポートを通して Zaber デバイスとの通

信を制御します。 すべての Arduino ボードには少なくとも 1 つのシリアルポートがあるので、すべての

Arduino ボードには基本的なシリアルクラスがあります。ただし、Arduino ボードに複数のシリアルポー

トがある場合は、クラス Serial1、Serial2、Serial3 を追加で利用でき、Zaber 以外のデバイスとの同時

制御、またはデバッグ印刷が可能になります。Zaber X-Series Shield では、ライブラリで提供されてい

る ZaberShield という別のシリアルクラスを使用する必要があります。 



Zaber devices, or debug-printing. The Zaber X-Series Shield requires the use of a different serial class 

called ZaberShield, which is provided in the library. 

First we'll define and initialize an instance of the ZaberShield class. This instance needs to be provided 

with information about the address jumper setting on the board. 

#include <ZaberAscii.h> 

 

ZaberShield shield(ZABERSHIELD_ADDRESS_AA); 

Common Questions 

What is an instance and why do I need one? 

Our name shield is an instance of our ZaberShield class, initialized using the a numeric constant that 

sets the address to use. This instance is a section of memory used to store a copy of the 

ZaberShield class's data and which lets us utilize all of the functions of the class. We could potentially 

create other instances of ZaberShield, giving them each a different name, and each would keep track 

of its own internal state independently. 

What is a class? 

A class is a group of zero or more pieces of data and the functions that operate on that data. Classes 

make code conceptually more like real-world objects by grouping behavior and data together, and are 

the core concept of object-oriented programming. 

What is a constructor? 

A constructor is a method that is called when we want to create an instance. The parameters passed 

into the constructor are what create the instance. In our case, we construct shield with 

ZABERSHIELD_ADDRESS_AA as a parameter to the constructor. 

What does initialization mean? 

Initialization means setting the initial state of an instance. For numeric data this is just assigning its 

first value. For class instances this means calling the constructor, which is in turn responsible for 

initializing the internal data of the class. 

What is a global variable? 

A global variable is one that can be accessed anywhere in the program - it has the highest scope, 

declared at the top of a file in order to allow all nested functions access to it. In the example above, 

shield is a global variable. Examples of variables that are not globel are those that are declared inside 

a class or inside a function. 

The above code configures a global variable named shield to be an instance of the ZaberShield serial 

port class using port address 0x90. The name ZABERSHIELD_ADDRESS_AA is one of four constants that 

are defined in the library for this purpose, when names ending in AA, AB, BA, and BB. The first letter in 

まず、ZaberShield クラスのインスタンスを定義して初期化します。 このインスタンスには、ボード上の

アドレスジャンパ設定に関する情報を提供する必要があります。 

#include <ZaberAscii.h> 

 

ZaberShield shield(ZABERSHIELD_ADDRESS_AA); 
 
よくある質問 

インスタンスとは何ですか。なぜ必要なのですか？ 

私たちのネームシールドは、使用するアドレスを設定する数値定数を使用して初期化された ZaberShield クラスの

インスタンスです。 このインスタンスは、ZaberShield クラスのデータのコピーを保存するために使用されるメモリ

のセクションであり、それによってクラスのすべての機能を利用することができます。 ZaberShield の他のインスタ

ンスを作成し、それぞれに異なる名前を付けることで、それぞれが独自の内部状態を個別に追跡することができ

ます。 

クラスとは？ 

クラスとは、ゼロ個以上のデータとそのデータを処理する関数の集まりです。 クラスは、振る舞いとデータをグ

ループ化することによって、概念的にコードを実世界のオブジェクトに似せるものであり、オブジェクト指向プログ

ラミングの中核的概念です。 

コンストラクタとは何ですか？ 

コンストラクタは、インスタンスを作成したいときに呼び出されるメソッドです。 コンストラクタに渡されるパラメータ

は、インスタンスを作成するものです。 この例では、コンストラクタへのパラメータとして

ZABERSHIELD_ADDRESS_AA を使用して shield を構築します。 

初期化とはどういう意味ですか？ 

初期化とは、インスタンスの初期状態を設定することです。 数値データの場合、これは最初の値を代入するだ

けです。 クラスインスタンスの場合、これはコンストラクタを呼び出すことを意味します。コンストラクタは、クラス

の内部データの初期化を担当します。 

グローバル変数とは？ 

グローバル変数は、プログラム内のどこからでもアクセスできる変数です。これは、すべてのネストした関数が

アクセスできるようにするために、ファイルの先頭で宣言された最高の有効範囲を持ちます。 上記の例では、

shield はグローバル変数です。 グローバルではない変数の例としては、クラス内または関数内で宣言されてい

るものがあります。 

上記のコードは、shield という名前のグローバル変数を、ポートアドレス 0x90 を使用する ZaberShield シリアル

ポートクラスのインスタンスになるように設定します。 ZABERSHIELD_ADDRESS_AA という名前は、この目的の

ためにライブラリーに定義されている 4 つの定数のうちの 1 つです（名前が AA、AB、BA、および BB で終わる

場合）。 



these constant names suffixes corresponds to the AD1 jumper position, and the second letter 

corresponds to the AD0 jumper position. You must use the constant that matches the jumper setting 

on your shield. 

 

The port address is configured using jumpers on the Zaber shield. The address is configurable in order 

to make it possible to avoid conflict with other shields that want to use a given address for another 

purpose. 

Next, we'll define the instance of the ZaberAscii class as a global variable named za, and pass in the 

shield class we created above. 

Note in the incremental code examples below, changes are highlighted with comments saying "this line 

is new". You don't need to include those comments in your code. 

#include <ZaberAscii.h> 

 

ZaberShield shield(ZABERSHIELD_ADDRESS_AA); 

ZaberAscii za(shield);  // <-- This line is new. 

Setting the Baudrate 

Now that a ZaberAscii instance has been initialized, it is important to set and match the baudrate to 

the device. Zaber X-Series devices, by default, use a baudrate of 115200. Let's initialize the 

ZaberShield class with this baudrate in the setup() function, to be called at startup: 

#include <ZaberAscii.h> 

 

ZaberShield shield(ZABERSHIELD_ADDRESS_AA); 

ZaberAscii za(shield); 

 

void setup() { 

    /* Initialize baudrate to 115200, typical for Zaber ASCII devices */  // <-- This 

line is new. 

    shield.begin(115200);                                                 // <-- This 

line is new. 

} 

Issuing a Command to the Zaber Device 

ポートアドレスは Zaber シールドのジャンパを使って設定できます。他の目的のために与えられたアドレ

スを使いたい別のシールドとの衝突を避けられるようにアドレスは設定可能です 

次に、ZaberAscii クラスのインスタンスを za という名前のグローバル変数として定義し、上で作成したシ

ールドクラスを渡します。 

以下の増分コード例では、「この行は新しいです」というコメントで変更が強調されています。 これらのコ

メントをコードに含める必要はありません。 

#include <ZaberAscii.h> 

 

ZaberShield shield(ZABERSHIELD_ADDRESS_AA); 

ZaberAscii za(shield);  // <-- This line is new. 
 
ボーレートの設定 

ZaberAscii インスタンスが初期化されたので、ボーレートを設定してデバイスに合わせることが重要で

す。 Zaber X シリーズデバイスは、デフォルトで 115200 のボーレートを使用します。setup（）関数で、

このボーレートを使用して ZaberShield クラスを初期化しましょう。起動時に呼び出されます。 

#include <ZaberAscii.h> 

 

ZaberShield shield(ZABERSHIELD_ADDRESS_AA); 

ZaberAscii za(shield); 

 

void setup() { 

    /* Initialize baudrate to 115200, typical for Zaber ASCII devices */  // <-- This 

line is new. 

    shield.begin(115200);                                      // <-- This line is new. 

} 
 

Zaber デバイスにコマンドを発行 

これらの定数名の接尾辞の最初の文字は AD1 のジャンパ位置に対応し、2 番目の文字は AD0 のジャンパ位

置に対応します。 シールドのジャンパ設定と一致する定数を使用する必要があります。 
 



With all of the serial communications setup out of the way, we can now send commands to the device. 

Commands are sent to a ZaberAscii instance with the send(int deviceNumber, String command, 

long int data) function. The parameters of this function are as follows: 

 The int deviceNumber can be found by looking in Zaber Console, but is by default 1 for new 

devices. It is the address of the device in a series of devices all connected to the same serial 

port, and if you have multiple devices on the same port you must configure them to each have a 

different number. Additionally, issuing a command with deviceNumber = 0 will send the 

command to all devices. 

 The various String command values available can be found by looking at the Zaber ASCII 

Protocol Manual. For this example, we'll use the "home" command. 

 Finally, if a command string requires data to be sent (for example, the distance for the device to 

move), the data can be passed through the long int data parameter. Note that this parameter 

is optional, and if a command string does not require additional data to be sent, it can be 

ignored. 

Common Questions 

What is a parameter? 

Code functions, like mathematical functions, can be parameterized and can return results. Parameters 

(also called arguments) are data that you give to a function when you call it. The code inside the 

function may make use of that data in order to determine what to do, or as part of its internal 

calculations. 

Let's issue the home command to our device number 1 using the predefined home command string, 

right after setting the baudrate. This command does not require any data to be passed through. 

/* Issue a home command to device 1 */ 

za.send(1, "home"); 

In most cases, when you send a command to a device, you should read its reply - even if you don't use 

the reply for anything. If you do not read the reply, it will wait in the Arduino's serial port receive buffer 

until you do try to read a reply. If you don't read every reply, you can end up reading the reply to a 

previous command by accident, or the receive buffer can overflow causing you to read corrupted 

replies. The receive() function will read one reply. In this example we read and ignore the reply by not 

assigning the function's return value to a variable: 

/* Always read the reply even if not checking it for errors. */ 

za.receive(); 

Your code should now look as follows: 

#include <ZaberAscii.h> 

 

ZaberShield shield(ZABERSHIELD_ADDRESS_AA); 

ZaberAscii za(shield); 

すべてのシリアル通信設定が邪魔にならないように, これでデバイスにコマンドを送信できます。 コマ

ンドは、send（int deviceNumber、String コマンド、long int data）関数を使用して ZaberAscii インスタンス

に送信されます。この関数のパラメータは次のとおりです。 

・int deviceNumber は Zaber コンソールで確認できますが、新しいデバイスの場合はデフォルトで 1 です。

これは、すべて同じシリアルポートに接続されている一連のデバイスの中のデバイスのアドレスです。同じ

ポートに複数のデバイスがある場合は、それぞれ異なる番号を設定する必要があります。さらに、

deviceNumber = 0 でコマンドを発行すると、そのコマンドはすべてのデバイスに送信されます。 

 利用可能なさまざまな String コマンドの値は、Zaber ASCII Protocol Manual を見ればわか

ります。 この例では、 "home"コマンドを使います。 

 最後に、コマンド文字列にデータの送信が必要な場合（たとえば、デバイスが移動する距

離など）、データは long int data パラメータを介して渡すことができます。このパラメータは

オプションであり、コマンド文字列が追加のデータの送信を必要としない場合は無視できま

す。 

よくある質問 

パラメータとは何ですか？ 

数学関数のようなコード関数は、パラメータ化して結果を返すことができます。パラメータ（引数とも呼

ばれる）は、関数を呼び出すときに関数に渡すデータです。関数内部のコードは、何をすべきかを決

定するために、またはその内部計算の一部として、そのデータを利用することができます。 

ボーレートを設定した直後に、定義済みの home コマンド文字列を使用して、デバイス番号 1 に home

コマンドを発行しましょう。 このコマンドでは、データを渡す必要はありません。 

/*デバイスにホームコマンドを発行 1 */ 

za.send(1, "home"); 

ほとんどの場合、デバイスにコマンドを送信するときは、その応答を読む必要があります。たとえその応

答を何にも使用しなくてもです。返事を読んでいない場合は、返事を読もうとするまで Arduino のシリア

ルポート受信バッファで待機します。すべての返信を読んでいないと、誤って前のコマンドへの返信を読

んだり、受信バッファがオーバーフローして破損した返信を読んだりする可能性があります。receive（）

関数は一つの返事を読むでしょう。 この例では、関数の戻り値を変数に代入しないことによって応答を

読んで無視します。 

/*エラーをチェックしていなくても、必ず返信を読んでください。 */ 

za.receive(); 

コードは次のようになります: 

#include <ZaberAscii.h> 

 

ZaberShield shield(ZABERSHIELD_ADDRESS_AA); 

ZaberAscii za(shield); 

 



 
void setup() { 

    /* Initialize baudrate to 115200, typical for Zaber ASCII devices */ 

    shield.begin(115200); 

 

    /* Issue a home command to device 1 */                    // <-- This line is new. 

    za.send(1, "home");                                       // <-- This line is new. 

 

    /* Always read the reply even if not checking it for errors. */  // <-- This line is new. 

    za.receive();                                             // <-- This line is new. 

} 

 

void loop() { 

 

} 

Compiling and Running the Program On Your Arduino Board 

You are now ready to run the program. Plug in your Arduino board via the USB connector to your PC, 

and set the following options: 

 Under "Tools", check that the correct port is selected (you should see your Arduino board 

name by the port number in brackets) 

 Under "Tools", set "Board" to the appropriate board that you have (this should be the same as 

the board name you saw in brackets when selecting a port) 

Now, click the upload button (the right-facing arrow next to the checkmark button at the top of the 

IDE) to compile and upload the program to your Arduino board. The program should run as soon as it 

has been uploaded, and send the home command to the Zaber device, if you have the device 

connected to your Zaber shield. 

 

Intermediate ASCII Example 

If you'd like, you can follow along with this guide to learn about how the program is written; 

alternatively, you can navigate within the Arduino IDE to File -> Examples -> Zaber ASCII, and 

click on the Intermediate_LED example to load the completed code into the Arduino IDE. 

Perhaps you are working overnight, and you only want to monitor devices that are not currently at their 

home position. The devices that are at their home position are not currently in use, but are still 

receiving power, and you'd like a way to differentiate them from the devices that are receiving power 

but not in their home positions. Using our Arduino knowledge, we can write a fairly simple script to fix 

this problem. 

We'll start our program as before, creating an instance of the Zaber Ascii class, and initializing the 

baudrate to 115200 in the setup() function: 

    /* Always read the reply even if not checking it for errors. */  //<-- This line is new. 
    za.receive();                                             // <-- This line is new. 
} 
 
void loop() { 
 
} 
 

Arduino ボード上でプログラムをコンパイルして実行する 

void setup() { 
    /* Initialize baudrate to 115200, typical for Zaber ASCII devices */ 
    shield.begin(115200); 
 
    /* Issue a home command to device 1 */                    // <-- This line is new. 
    za.send(1, "home");                                       // <-- This line is new. 

これでプログラムを実行する準備が整いました。 USB コネクタを介して Arduino ボードを PC に接続

し、以下のオプションを設定します。 

 [Tools]の中で、正しいポートが選択されていることを確認します（Arduino のボード名はかっこ内

のポート番号で表示されます）。 

 [ツール]の中で、[ボード]を適切なボードに設定します（これは、ポートを選択するときに括弧で囲

まれたボード名と同じになります）。 

ここで、アップロードボタン（IDE 上部のチェックマークボタンの横にある右向きの矢印）をクリックして、プ

ログラムをコンパイルして Arduino ボードにアップロードします。 プログラムがアップロードされるとすぐ

に実行され、Zaber シールドにデバイスが接続されている場合は Zaber デバイスに home コマンドを送信

します。 

中級 ASCII プログラム例 

ご希望の場合は、このガイドに従って、プログラムの書き方について学ぶことができます。 あるいは、

Arduino IDE 内で File - > Examples - > Zaber ASCII の順にナビゲートし、Intermediate_LED の例をク

リックして完成したコードを Arduino IDE にロードすることもできます。 

おそらくあなたは一晩中働いていて、あなたは現在彼らのホームポジションにいない機器だけをモニタ

ーしたいと思うでしょう。 ホームポジションにあるデバイスは現在使用されていませんが、まだ電力を

受けているため、電源を供給されているがホームポジションにいないデバイスと区別するための方法が

必要です。 Arduino の知識を使用して、この問題を解決するためのかなり簡単なスクリプトを書くことが

できます。 

Zaber Ascii クラスのインスタンスを作成し、setup（）関数でボーレートを 115200 に初期化して、以前と

同じようにプログラムを起動します。 



#include <ZaberAscii.h> 

 

ZaberShield shield(ZABERSHIELD_ADDRESS_AA); 

ZaberAscii za(shield); 

 

void setup() { 

    /* Initialize baudrate to 115200, typical for Zaber ASCII devices */ 

    shield.begin(115200); 

} 

 

void loop() { 

 

} 

Next, we'll query for the device's position in the loop function. This function runs continuously until the 

Arduino loses power or the program halts. This way, by checking if the device's position is 0, we can 

turn the device's LED lights on or off. First, send the request for the position of the device. 

#include <ZaberAscii.h> 

 

ZaberShield shield(ZABERSHIELD_ADDRESS_AA); 

ZaberAscii za(shield); 

 

void setup() { 

    /* Initialize baudrate to 115200, typical for Zaber ASCII devices */ 

    shield.begin(115200); 

} 

 

void loop() { 

    /* Issue a get position command to the device */           // <-- This line is new. 

    za.send(1, "get pos");                                     // <-- This line is new. 

} 

Next, we'll want to receive and analyze the response. This can be done using the receive function, 

which returns a reply struct. A response from the Zaber ASCII library takes the form of a struct 

reply. You can see the declatation of the reply struct in ZaberAscii.h. See the Interpreting Replies 

section for more information about responses. 

Common Questions 

What is a struct? 

A struct (short for "structure") is a container for multiple pieces of data, like a class. Unlike a class, 

structs usually do not contain functions. There are also differences between how structs and classes 

are copied to new variables by the equals sign. 

For now, store the reply from the device into a local variable. 

#include <ZaberAscii.h> 

 

ZaberShield shield(ZABERSHIELD_ADDRESS_AA); 

ZaberAscii za(shield); 

 

void setup() { 

    /* Initialize baudrate to 115200, typical for Zaber ASCII devices */ 

    shield.begin(115200); 

} 

 

void loop() { 

 

} 

次に、ループ機能におけるデバイスの位置を問い合わせます。 この機能は Arduino の電源が切れるかプログラムが

停止するまで継続して実行されます。 このように、デバイスの位置が 0 かどうかを確認することで、デバイスの LED

ライトをオンまたはオフにすることができます。 まず、デバイスの位置を求めるリクエストを送信します。 

#include <ZaberAscii.h> 

 

ZaberShield shield(ZABERSHIELD_ADDRESS_AA); 

ZaberAscii za(shield); 

 

void setup() { 

    /* Initialize baudrate to 115200, typical for Zaber ASCII devices */ 

    shield.begin(115200); 

} 

 

void loop() { 

    /* Issue a get position command to the device */           // <-- This line is new. 

    za.send(1, "get pos");                                     // <-- This line is new. 

} 

次に、レスポンスを受け取って分析します。 これは reply 構造体を返す receive 関数を使って実行で

きます。 Zaber ASCII ライブラリからの応答は、struct reply の形式を取ります。 ZaberAscii.h で reply

構造体の宣言を見ることができます。 回答の詳細については、回答の解釈のセクションを参照して

ください。 

よ く あ る 質 問

構造体とは何ですか？ 

構造体（「構造体」の略）は、クラスのように複数のデータを格納するためのコンテナです。 クラスとは

異なり、構造体は通常関数を含みません。 等号によって構造体とクラスが新しい変数にコピーされる

方法にも違いがあります。 

今のところ、デバイスからの応答をローカル変数に格納します。 



#include <ZaberAscii.h> 

 

ZaberShield shield(ZABERSHIELD_ADDRESS_AA); 

ZaberAscii za(shield); 

 

void setup() { 

    /* Initialize baudrate to 115200, typical for Zaber ASCII devices */ 

    shield.begin(115200); 

} 

 

void loop() { 

    /* Issue a get position command to the device */ 

    za.send(1, "get pos"); 

 

    /* Create a variable to store the device response inside */     // <-- This line is new. 

    ZaberAscii::reply posResponse = za.receive();                   // <-- This line is new. 

} 

We only want the data from the response, as it contains the device's position from our issued "get 

pos" command. This will be in the long int responseData variable of the reply struct. Thus, we use 

an if statement on the variable to check whether it is 0, or any other value. 

#include <ZaberAscii.h> 

 

ZaberShield shield(ZABERSHIELD_ADDRESS_AA); 

ZaberAscii za(shield); 

 

void setup() { 

    /* Initialize baudrate to 115200, typical for Zaber ASCII devices */ 

    shield.begin(115200); 

} 

 

void loop() { 

    /* Issue a get position command to the device */ 

    za.send(1, "get pos"); 

 

    /* Create a variable to store the device response inside */ 

    ZaberAscii::reply posResponse = za.receive(); 

 

    /* Check if the device is currently at the home position */    // <-- This line is new. 

    if (posResponse.responseData == 0)                             // <-- This line is new. 

    {                                                              // <-- This line is new. 

                                                                   // <-- This line is new. 

    }                                                              // <-- This line is new. 

    else                                                           // <-- This line is new. 

    {                                                              // <-- This line is new. 

                                                                   // <-- This line is new. 

    }                                                              // <-- This line is new. 

} 

#include <ZaberAscii.h> 

 

ZaberShield shield(ZABERSHIELD_ADDRESS_AA); 

ZaberAscii za(shield); 

 

void setup() { 

    /* Initialize baudrate to 115200, typical for Zaber ASCII devices */ 

    shield.begin(115200); 

} 

 

void loop() { 

    /* Issue a get position command to the device */ 

    za.send(1, "get pos"); 

 

    /* Create a variable to store the device response inside */     // <-- This line is new. 

    ZaberAscii::reply posResponse = za.receive();                   // <-- This line is new. 

} 

----------------------------------------------------------------------- 

レスポンスからのデータは、発行された "get pos"コマンドからのデバイスの位置が含まれているために

必要です。 これは、応答構造体の long int responseData 変数にあります。 したがって、変数に if 文を

使用して、それが 0 かそれ以外の値かを確認します。 

------------------------------------------------------------------ 
#include <ZaberAscii.h> 

 

ZaberShield shield(ZABERSHIELD_ADDRESS_AA); 

ZaberAscii za(shield); 

 

void setup() { 

    /* Initialize baudrate to 115200, typical for Zaber ASCII devices */ 

    shield.begin(115200); 

} 

 

void loop() { 

    /* Issue a get position command to the device */ 

    za.send(1, "get pos"); 

 

    /* Create a variable to store the device response inside */ 

    ZaberAscii::reply posResponse = za.receive(); 

 

    /* Check if the device is currently at the home position */    // <-- This line is new. 

    if (posResponse.responseData == 0)                             // <-- This line is new. 

    {                                                              // <-- This line is new. 

                                                                   // <-- This line is new. 

    }                                                              // <-- This line is new. 

    else                                                           // <-- This line is new. 

    {                                                              // <-- This line is new. 

                                                                   // <-- This line is new. 

    }                                                              // <-- This line is new. 

} 
 



Finally, we can issue a command to turn the LED lights off if the device is in the home position. If the 

device is not at the home position (inside the else{}), we want to continue to monitor the device, and 

thus turn the LED lights on. 

#include <ZaberAscii.h> 

 

ZaberShield shield(ZABERSHIELD_ADDRESS_AA); 

ZaberAscii za(shield); 

 
void setup() { 

    /* Initialize baudrate to 115200, typical for Zaber ASCII devices */ 

    shield.begin(115200); 

} 

 

void loop() { 

    /* Issue a get position command to the device */ 

    za.send(1, "get pos"); 

 

    /* Create a variable to store the device response inside */ 

    ZaberAscii::reply posResponse = za.receive(); 

 

    if (posResponse.responseData == 0) 

    { 

        /* Set the device's LED lights to OFF if it is at home */     // <-- This line is new. 

        za.send(1, "set system.led.enable", 0);                       // <-- This line is new. 

    } 

    else 

    { 

        /* Set the device's LED lights to ON */                       // <-- This line is new. 

        za.send(1, "set system.led.enable", 1);                       // <-- This line is new. 

    } 

 

    /* Always read the reply, even if not using it. */                // <-- This line is new. 

    /* Since each of the if/else blocks above only sends one */       // <-- This line is new. 

    /* command, we can read either reply outside the blocks, here. */ // <-- This line is new. 

    za.receive();                                                     // <-- This line is new. 

} 

You can now upload this program to your Arduino, and you'll notice that any device that is at the home 

position will have its power LED lights and communication LED lights turned off. If you move the device 

away from the home position (using one of the knobs) you'll see the LED lights turn back on, ready to 

be monitored. 

 

Using the Serial Monitor to Debug Your Code 

One of the advantages of using the X-Series Shield to connect to your Arduino is that the X-Series 

Shield does not use up serial ports on the Arduino. This lets you print out debug information on the 

最後に、デバイスがホームポジションにある場合、LED ライトを消すコマンドを発行できます。 デバイス

がホームポジション（else { }の内側）にない場合は、引き続きデバイスを監視し、LED を点灯させます。 

#include <ZaberAscii.h> 

 

ZaberShield shield(ZABERSHIELD_ADDRESS_AA); 

ZaberAscii za(shield); 

 
void setup() { 

    /* Initialize baudrate to 115200, typical for Zaber ASCII devices */ 

    shield.begin(115200); 

} 

 

void loop() { 

    /* Issue a get position command to the device */ 

    za.send(1, "get pos"); 

 

    /* Create a variable to store the device response inside */ 

    ZaberAscii::reply posResponse = za.receive(); 

 

    if (posResponse.responseData == 0) 

    { 

        /* Set the device's LED lights to OFF if it is at home */     // <-- This line is new. 

        za.send(1, "set system.led.enable", 0);                       // <-- This line is new. 

    } 

    else 

    { 

        /* Set the device's LED lights to ON */                       // <-- This line is new. 

        za.send(1, "set system.led.enable", 1);                       // <-- This line is new. 

    } 

 

    /* Always read the reply, even if not using it. */                // <-- This line is new. 

    /* Since each of the if/else blocks above only sends one */       // <-- This line is new. 

    /* command, we can read either reply outside the blocks, here. */ // <-- This line is new. 

    za.receive();                                                     // <-- This line is new. 

} 
 
これであなたは Arduino にこのプログラムをアップロードすることができます、そしてあなたはホームポ

ジションにあるどんな装置でもその電源 LED ライトと通信 LED ライトが消えることに気付くでしょう。 （ノ

ブの 1 つを使用して）デバイスをホームポジションから遠ざけると、LED ライトが再び点灯して監視でき

るようになります。 

シリアルモニタを使ってコードをデバッグ 

X シリーズシールドを使用して Arduino に接続する利点の 1 つは、X シリーズシールドが Arduino のシ

リアルポートを使い切らないことです。 



Serial Monitor at the same time as communicating with Zaber devices. Building on the previous 

example: 

#include <ZaberAscii.h> 

 

ZaberShield shield(ZABERSHIELD_ADDRESS_AA); 

ZaberAscii za(shield); 

 

void setup() { 

    /* Initialize baudrate to 115200, typical for Zaber ASCII devices */ 

    shield.begin(115200); 

 

    /* Initialize Arduino's serial port for debugging */              // <-- This line is new. 

    Serial.begin(9600);                                               // <-- This line is new. 

} 

void loop() { 

    /* Issue a get position command to the device */ 

    za.send(1, "get pos"); 

 

    /* Create a variable to store the device response inside */ 

    ZaberAscii::reply posResponse = za.receive(); 

 

    if (posResponse.responseData == 0) 

    { 

        /* Set the device's LED lights to OFF if it is at home */ 

        za.send(1, "set system.led.enable", 0); 

 

        /* Send a debug message to the Serial Monitor */              // <-- This line is new. 

        Serial.print("Position: 0 (homed!)\t");                       // <-- This line is new. 

        Serial.println("LED should be OFF");                          // <-- This line is new. 

    } 

    else 

    { 

        /* Set the device's LED lights to ON */ 

        za.send(1, "set system.led.enable", 1); 

 

        /* Send a debug message to the Serial Monitor */              // <-- This line is new. 

        Serial.print("Position: ");                                   // <-- This line is new. 

        Serial.print(posResponse.responseData);                       // <-- This line is new. 

        Serial.println("\t\tLED should be ON");                       // <-- This line is new. 

    } 

 

    /* Always read the reply, even if not using it. */ 

    /* Since each of the if/else blocks above only sends one */ 

    /* command, we can read either reply outside the blocks, here. */ 

    za.receive(); 

 

    /* Add a delay to limit polling to 2 times per second */          // <-- This line is new. 

    delay(500);                                                       // <-- This line is new. 

} 

これにより、Zaber デバイスとの通信と同時にデバッグ情報をシリアルモニターに印刷できます。  

前述の例の上に追加： 

#include <ZaberAscii.h> 

 

ZaberShield shield(ZABERSHIELD_ADDRESS_AA); 

ZaberAscii za(shield); 

 

void setup() { 

    /* Initialize baudrate to 115200, typical for Zaber ASCII devices */ 

    shield.begin(115200); 

 

    /* Initialize Arduino's serial port for debugging */             // <-- This line is new. 

    Serial.begin(9600);                                              // <-- This line is new. 

} 

void loop() { 

    /* Issue a get position command to the device */ 

    za.send(1, "get pos"); 

 

    /* Create a variable to store the device response inside */ 

    ZaberAscii::reply posResponse = za.receive(); 

 

    if (posResponse.responseData == 0) 

    { 

        /* Set the device's LED lights to OFF if it is at home */ 

        za.send(1, "set system.led.enable", 0); 

 

        /* Send a debug message to the Serial Monitor */             // <-- This line is new. 

        Serial.print("Position: 0 (homed!)\t");                      // <-- This line is new. 

        Serial.println("LED should be OFF");                         // <-- This line is new. 

    } 

    else 

    { 

        /* Set the device's LED lights to ON */ 

        za.send(1, "set system.led.enable", 1); 

 

        /* Send a debug message to the Serial Monitor */             // <-- This line is new. 

        Serial.print("Position: ");                                  // <-- This line is new. 

        Serial.print(posResponse.responseData);                      // <-- This line is new. 

        Serial.println("\t\tLED should be ON");                      // <-- This line is new. 

    } 

 

    /* Always read the reply, even if not using it. */ 

    /* Since each of the if/else blocks above only sends one */ 

    /* command, we can read either reply outside the blocks, here. */ 

    za.receive(); 

 

    /* Add a delay to limit polling to 2 times per second */         // <-- This line is new. 

    delay(500);                                                      // <-- This line is new. 

} 
 



Let's now upload the program to your Arduino and open the Serial Monitor in the Arduino IDE. You can 

do this either by clicking Tools -> Serial Monitor, or using the Ctrl+Shift+M shortcut. Make sure 

your baud rate is set to 9600 to match the code. Assuming your serial port is still configured properly 

in the IDE, you should see printouts similar to the one below, updating about twice per second. 

 

You can also try to use the Serial Plotter (Tools -> Serial Plotter, or Ctrl+Shift+L) to graphically 

follow your device's position. 

 

Interpreting Replies 

Some additional comments about how to interpret device replies. As mentioned earlier, the reply data 

structure contains the following fields: 

 String fullResponse: The entire unparsed response String 

 bool isReply: Evaluates to true if the response is a reply 

 int deviceNumber: Evaluates to the device number that the command response is in relation to 

 int axisNumber: Evaluates to the axis number that the command response is in relation to 

 bool isRejected: Returns true if the command was rejected by the device 

 bool isBusy: Returns true if the device was busy and could not receive the command 

 bool hasWarning: Returns true if the command presented a warning from the device 

 String warningFlags: A string containing the warning flags if a warning was issued 

 String responseDataString: The data attached to the response in a String variable 

 long int responseData: The data attached to the response in a Integer variable 

If you want to be sure you are examining the correct reply to a command, you should check that the 

deviceNumber matches the device you expected to get a message from, and that isReply is true. If 

isReply is false, it means you have either an alert or an info message - you will have to check the first 

character of fullResponse to determine which if you want to handle these message types. Alerts start 

with '!' and info messages start with '#'. 

Before using the data in a reply, you should make sure the command executed successfully. Check 

isRejected to make sure the device didn't refuse the command, and check isBusy to see if the device 

is currently moving or not. You can use the isIdle or pollUntilIdle methods of the ZaberAscii 

class to check for moving/idle status without having to interpret this data yourself. 

それでは、プログラムを Arduino にアップロードし、Arduino IDE でシリアルモニターを開きましょう。これを行うに

は、[Tooll] - > [Serial Monitor]をクリックするか、Ctrl + Shift + M のショートカットを使用します。コードと一致する

ようにボーレートが 9600 に設定されていることを確認してください。シリアルポートがまだ IDE で正しく設定されて

いると仮定すると、以下のような印刷が表示されるはずです。毎秒約 2 回更新されます。 

シリアルプロッタ（[ツール] - > [シリアルプロッタ]、または[Ctrl] + [Shift] + [L]）を使ってデバイスの位置

をグラフィカルに追跡することもできます。 

返信の解釈 

デバイスの返信を解釈する方法に関するいくつかの追加のコメント。 前述のように、応答データ構造

には以下のフィールドが含まれています。 

 String fullResponse：未解析のレスポンス文字列全体。 

 bool isReply：応答が返答であれば真と評価される 

 int deviceNumber：コマンド応答が関連していることをデバイス番号に評価します。 

 int axisNumber：コマンド応答が関連する軸番号に評価されます。 

 bool isRejected：コマンドがデバイスによって拒否された場合は true を返します。 

 bool isBusy：デバイスがビジー状態でコマンドを受信できなかった場合は true を返します。 

 bool hasWarning：コマンドがデバイスから警告を表示した場合は true を返します。 

 String warningFlags：警告が発行された場合は警告フラグを含む文字列 

 String responseDataString：文字列変数でレスポンスに添付されたデータ 

 long int responseData：整数変数内の応答に添付されたデータ。 

 

コマンドに対する正しい応答を確認していることを確かめたい場合は、deviceNumber がメッセージの取

得先と予想されるデバイスと一致していることを確認する必要があります。それから isReply は true で

す。 isReply が false の場合は、アラートまたは情報メッセージがあることを意味します。これらのメッセ

ージタイプを処理する場合は、fullResponse の最初の文字を確認する必要があります。アラートは '！'

で始まります 情報メッセージは '＃'で始まります。 

返信にデータを使用する前に、コマンドが正常に実行されたことを確認する必要があります。isRejected

をチェックしてデバイスがコマンドを拒否していないことを確認し、isBusy をチェックしてデバイスが現在

移動中かどうかを確認します。ZaberAscii クラスの isIdle または pollUntilIdle メソッドを使用して、このデ

ータを自分で解釈しなくても、移動/アイドル状態を確認できます。 



For most commands that return a data value, the responseData field will give you the value in numeric 

form. There are some cases where you will want to parse the data yourself from the 

responseDataString field though - in cases where the returned data has a decimal place, multiple 

values, numbers too large to fit in a 32-bit signed integer, or non-numeric data. 

The hasWarning and warningFlags fields indicate whether the device is reporting a warning state. 

Whether or nor a flag indicates a condition you should care about depends on which flags are present 

and on your usage context. Check the warning flags section of the Zaber ASCII protocol manual for 

interpretation. Also be aware that multiple warnings can be active at once, but a reply normally only 

contains the most urgent one. You can use the "warnings" command to retrieve of all of them. 

See the "Track Manual Moves" example program for some basic examples of interpreting reply 

conditions and also another way to avoid blocking your program while waiting for replies. 

 

Adding More Shields and Sensors 

It's a good idea to power everything down before connecting any new hardware. Consider the following 

when adding to your setup. 

1. I2C Address: if any of your other shields also use I2C to communicate with the Arduino... 

o Choose a unique address for the X-Series Shield from the following four options:  

 I2C address AA: 0x90 

 I2C address AB: 0x92 

 I2C address BA: 0x98 

 I2C address BB: 0x9A 

o If you change the address, you must power cycle the board for it to take effect. A simple 

reset won't work. 

o Make sure the address in your code (ZABERSHIELD_ADDRESS_xx), which is specified in 

the initialization of the ZaberShield class, matches your jumper settings. 

2. Power Source: once you're happy with your code, you can disconnect your Arduino from the 

computer and power it from an X-Series Zaber device! 

o At this point, you can switch the Power Source jumper to the "X-Series Power" 

position. 

o If you want to still supply power to your Arduino via the barrel jack power input or the 

Vin pin, you must leave the jumper in the "Vin/USB" position! 

3. Ruggedized I/O: if you want a bit of protection for the extra signals you're connecting, read this 

Appendix. 

My Program Isn't Working! 

The program won't upload to the Arduino board 

 Check your Port and Board settings under Tools -> Board: and Tools -> Port:. 

データ値を返すほとんどのコマンドでは、応答の Data フィールドに値が数値形式で表示されます。た

だし、responseDataString フィールドから自分でデータを解析する必要がある場合もあります。返され

るデータに小数点以下の桁数、複数の値、32 ビット符号付き整数に収まらないほど大きい数、または

数値以外の場合 データ。 

hasWarning および warningFlags フィールドは、デバイスが警告状態を報告しているかどうかを示しま

す。 あなたが気にすべき条件を示しているかどうかは、どちらのフラグが存在するか、そしてあなたの

使用状況によって異なります。解釈については、Zaber ASCII プロトコルマニュアルの警告フラグのセク

ションを確認してください。また、複数の警告が一度にアクティブになることがありますが、返信には通

常最も緊急の警告のみが含まれます。「warnings」コマンドを使用してそれらすべてを取得できます。 

返信条件の解釈の基本的な例や、返信を待っている間にプログラムがブロックされないようにするもう

1 つの方法については、「手動移動の追跡」サンプルプログラムを参照してください。 

より多くのシールドとセンサーを追加する場合 

新しいハードウェアを接続する前に、すべての電源を切ることをお勧めします。 セットアップに追加す

るときは、次の点を考慮してください。 

1. I2C アドレス：他の shield のいずれかが Arduino と通信するために I2C を使用している場合.... 

o 以下の 4 つのオプションから、X シリーズシールドに固有のアドレスを選択してください：  

 I2C address AA: 0x90 

 I2C address AB: 0x92 

 I2C address BA: 0x98 

 I2C address BB: 0x9A 

o アドレスを変更した場合は、有効にするためにボードの電源を入れ直す必要がありま

す。 単純なリセットは機能しません。 
o ZaberShield クラスの初期化で指定されているコード内のアドレス

（ZABERSHIELD_ADDRESS_xx）が、ジャンパー設定と一致していることを確認してください. 

2. 電源：コードに満足したら、Arduino をコンピューターから取り外して X シリーズ Zaber デバイス

から電源を入れることができます。 

o この時点で、電源ジャンパを「X シリーズ電源」の位置に切り替えることができます。. 

o バレルジャックの電源入力または Vin ピンを介して Arduino に電源を供給したい場合

は、ジャンパを「Vin / USB」の位置にしておく必要があります。 

3. 堅牢な I / O: 接続している余分な信号を少し保護したい場合は、この付録を読んでください。 

私のプログラムがうまく動作しない！ 

プログラムは Arduino ボードにアップロードされない。 

 [Tool] - > [Board]、および[Tool] - > [Port]で、ポートとボードの設定を確認して下さい. 



 If you are using the Zaber X-Series Shield, ensure that the shield is powered. The ON led in the 

bottom right corner should be lit. Make sure your Power Source jumper agrees with your wiring. 

 If you are using a non-Zaber RS-232 shield, make sure the shield is turned off. If your RS-232 

shield does not have an on/off switch, simply remove it when uploading to the Arduino. 

Remember to turn it back on after your program is uploaded. 

The device isn't recognizing my commands or seems to be moving/reacting randomly 

 Make sure that you are using the correct protocol and baudrate. By default, X-Series devices 

are in ASCII, 115200 baudrate, and T- and A-series devices are in Binary 9600 baudrate 

(except the A-MCB2). You can check the protocol and baudrate in Zaber Console, and switch 

between the two protocols using the options tab. Zaber Console provides easy accessibility to 

changing your device's protocol under its Options tab. Also confirm you are sending the correct 

commands. In the ASCII protocol, commands are identified as strings, such as "get pos" - the 

full list of commands for the ASCII protocol can be found here. 

I am not getting the replies I expect or there are too many replies 

 Make sure you are reading every response returned by each device. In most cases Zaber 

devices send one response for each command they receive, and treating them this way is 

usually sufficient for basic use. 

 Under certain conditions, devices can send spontaneous messages that are not replies to 

commands; in the ASCII protocol, you can configure the device to send an alert message when 

a condition is met, and some commands will append multiple info messages to their replies. The 

Zaber library does not automatically handle these spontaneous messages, so if you are working 

with devices that may generate them, you should check for them when reading replies and 

recognize that they do not count as the expected reply to your last command. 

The device is making high-pitched beeping noises whenever it moves 

Contact Zaber support at contact@zaber.com to ensure that your device was configured correctly. 

These fixes didn't work for me and my program still won't run 

Contact Zaber support at contact@zaber.com, detailing your Arduino board type, Zaber device model, 

Zaber or RS-232 shield type, and the Arduino code that refuses to run. 

Additional Example Programs 

More example programs are accessible through the Arduino IDE. Use the menu sequence File -> Examples -> 

Zaber ASCII to find all of the example programs included with this library. Each example contains comments 

explaining what it does. 

Appendix A: Using the Rugged I/O Interface 

We have chosen to ruggedize some of the Arduino's inputs and outputs and expose the protected 

signals on the black terminal block. They are not bulletproof, but going a couple volts outside of your 

 Zaber X シリーズシールドを使用している場合は、シールドに電源が入っていることを確認してください。 右

下隅にある ON の LED が点灯します。 電源ジャンパが配線と一致していることを確認してください。 

 Zaber 製以外の RS-232 シールドを使用している場合は、シールドがオフになっていることを確認してくださ

い。 RS-232 シールドにオン/オフスイッチがない場合は、Arduino にアップロードするときに外してください。 

あなたのプログラムがアップロードされた後にそれを再びオンにすることを忘れないでください。 

デバイスが私のコマンドを認識していないか、ランダムに移動/反応しているようです。 

 正しいプロトコルとボーレートを使用していることを確認してください。 デフォルトでは、X シリー

ズデバイスは ASCII、115200 ボーレート、T シリーズおよび A シリーズデバイスはバイナリ

9600 ボーレートです（A-MCB2 を除く）。 Zaber コンソールでプロトコルとボーレートを確認し、

オプションタブを使用して 2 つのプロトコルを切り替えることができます。 Zaber コンソールの

[オプション]タブでは、デバイスのプロトコルを簡単に変更できます。また、正しいコマンドを送

信していることを確認してください。 ASCII プロトコルでは、コマンドは "get pos"のように文字

列として識別されます。ASCII プロトコルのコマンドの全リストはここにあります。 

期待している返答が得られない、または返答が多すぎる 

 各機器から返されたすべての応答を読んでいることを確認してください。 ほとんどの場合、Zaber

デバイスは受信したコマンドごとに 1 つの応答を送信します。基本的な使用には、このように処

理すれば通常は十分です。 

 特定の条件下では、デバイスはコマンドに応答しないメッセージを自発的に送信できます。 

ASCII プロトコルでは、条件が満たされたときに警告メッセージを送信するようにデバイスを設定

することができます。また、いくつかのコマンドはそれらの応答に複数の情報メッセージを追加し

ます。 Zaber ライブラリはこれらの自発的なメッセージを自動的に処理しないので、それらを生成

する可能性のあるデバイスを使用している場合は、返信を読むときにそれらを確認し、最後のコ

マンドに対する期待される返信としてカウントしないことを認識してください。 

動くたびに、デバイスは高音のビープ音を鳴らしています 

お使いのデバイスが正しく設定されていることを確認するには、contact @ zaber.com で Zaber サポートに連絡して

ください。 

これらの修正は私にはうまくいきませんでしたし、私のプログラムはまだ実行できません。 

Arduino のボードタイプ、Zaber デバイスモデル、Zaber または RS-232 シールドタイプ、および実行を拒否する

Arduino コードの詳細については、contact @ zaber.com で Zaber サポートにお問い合わせください。 

追加のプログラム例 

その他のプログラム例は Arduino IDE を通してアクセス可能です。 このライブラリに含まれるすべてのプログラ

ム例を見つけるには、メニューシーケンス File - >Example - > Zaber ASCII を使用してください。 各例には、そ

の動作を説明するコメントが含まれています。 

付録 A：堅牢な I / O インタフェースの使用 

Arduino の入力と出力の一部を高耐久化し、保護された信号を黒い端子台に表示することを選択しま

した。 



Arduino's supply voltage will no longer kill your Arduino. We recommend using the protected terminal 

block inputs/outputs whenever possible, but you can always connect directly to the pin headers to get 

default Arduino bevavior. 

The ruggedized interface gives you access access to the following functions: 

 two analog inputs† (A0 and A1) 

 three PWM outputs (digital pins 3, 5 and 6) 

 four digital inputs or outputs (digital pins 3-6) 

 +5V, which is limited to 150mA and will disable if you draw more current 

†The max analog value that protected analog inputs can read is 1020 out of 1024. 

 

To connect to this connector, simply push your wire into the round hole. Spring-loaded clamps will hold 

it in place. 

To remove your wire, push into the narrow hole above the wire with the small slotted screwdriver that 

came with your X-Series Shield. 

For more details, take a look at the X-AS01 hardware overview. 

Appendix B: Getting Started Without Zaber's X-Series Shield 

If you do not have our recommended X-Series Shield: 

1. Mount the an RS-232 shield on top of the Arduino and plug the Arduino board in to your 

computer using the provided USB cable. 

2. To connect the Zaber device to the RS-232 shield, you will first need to convert the female 

DSUB9 into a Male DSUB9 using a null M/M adapter. 

3. If you are using a T- or A- series Zaber device, you will also need the T-DSUB9 adapter. If you 

are using an X-Series device, you will need the X-SDC cable. When uploading to the Arduino, 

ensure the RS-232 converter is OFF (switch located on the top). Note that T-series Zaber 

devices do not support the ASCII protocol; if you want to control a T-series device with an 

Arduino, you must use the Zaber Binary library for Arduino. 

4. Use the Serial class in your code instead of the ZaberAscii class. It has all of the same methods 

but does not need the port address passed to its constructor. 

彼らは防弾ほどの効力はありませんが、あなたの Arduino の供給電圧の外側に数ボルトが掛かっても、Arduino

が損傷受けることはありません。 可能な限り保護された端子台の入力/出力を使用することをお勧めします

が、Arduino の動作を初期化するためにいつでもピンヘッダに直接接続することができます。 

堅牢化されたインターフェースにより、以下の機能にアクセスすることができます。 

 2 つのアナログ入力†（A0 と A1） 

 3 つの PWM 出力（デジタルピン 3、5、および 6） 

 4 つのデジタル入力または出力（デジタルピン 3〜6） 

 +5V。150mA に制限されているため、さらに電流を引き込むと無効になります。 

†保護されたアナログ入力が読み取れる最大アナログ値は、1024 のうち 1020 です。 

このコネクタに接続するには、単純に接続ホールに所要のワイヤーを差し込んでください。 バネ付クラ

ンプで固定されます。 

ワイヤを取り外すには、X シリーズシールドに付属の小さなマイナスドライバを使ってワイヤの上の狭い

穴に押し込みます。 

詳細については、X-AS01 ハードウェアの概要をご覧ください。 

付録 B：Zaber の X シリーズシールドなしで使用開始 

弊社の推奨 X シリーズシールドがない場合 

1. Arduino の上に RS-232 シールドを取り付け、付属の USB ケーブルを使用して Arduino ボー

ドをコンピュータに差し込みます。 

2. Zaber デバイスを RS-232 シールドに接続するには、最初にヌル M / M アダプタを使用して、

メス DSUB9 をオス DSUB9 に変換する必要があります。 

3. T シリーズまたは A シリーズの Zaber デバイスを使用している場合は、T-DSUB9 アダプタも

必要です。 X シリーズデバイスを使用している場合は、X-SDC ケーブルが必要になります。

Arduino にアップロードするときは、RS-232 コンバータがオフになっていることを確認してくだ

さい（スイッチは上部にあります）。T シリーズの Zaber デバイスは ASCII プロトコルをサポー

トしていません。 Arduino で T シリーズデバイスを制御したい場合は、Arduino 用の Zaber 

Binary ライブラリを使用する必要があります 

4. コード内で ZaberAscii クラスの代わりに Serial クラスを使用します。 すべて同じメソッドを持

っていますが、ポートアドレスをそのコンストラクタに渡す必要はありません。 



Documentation 

Schematics for Zaber's X-Series Shield and a short hardware reference can be found here. 

Documentation for all of Zaber's library for Arduino can be found in the ZaberShield.h and ZaberAscii.h files. On 

a Windows PC, the typical installed location of these files is Documents\Arduino\libraries\ZaberAscii. 

ドキュメンテーション 

Zaber の X-Series Shield の回路図と短いハードウェアリファレンスはここにあります。. 

Arduino 用の Zaber のすべてのライブラリのドキュメントは、ZaberShield.h および ZaberAscii.h ファイルにありま

す。 Windows PC では、これらのファイルの一般的なインストール場所は Documents \ Arduino \ libraries 

\ ZaberAscii です。 

 
〒171-0022 東京都豊島区南池袋 3-18-35 

OK ビル 2 階 
Tel: 03-5924-6750 Fax:03-5924-6751 
E-mail: sales@technology-l.com  
URL: http://www.technology-link.jp 
 


